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WARRANTY 9(b)

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the media will be free
from defects in materials and workmanship for a period of three (3) months from the date of shipment. If any such medium or encoding
proves defective during the warranty period, Tektronix will provide a replacement in exchange for the defective medium. Except as to the
media on which this software product is furnished, this software product is provided “as is” without warranty of any kind, either express or
implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements or that the
operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period. If
Tektronix is unable to provide a replacement that is free from defects in materials and workmanship within a reasonable time thereafter,
Customer may terminate the license for this software product and return this software product and any associated materials for credit or
refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND
CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS
WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE
POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.
While using this product, you may need to access other parts of the system. Read the General Safety Summary in other
system manuals for warnings and cautions related to operating the system.
To Avoid Fire or Personal Injury

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before connecting the
probe to the circuit under test. Disconnect the probe input and the probe ground from the circuit under test before
disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.
Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this product, have it inspected by
qualified service personnel.

Do Not Operate in Wet/Damp Conditions.
Do Note Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

i TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Preface

Preface

The TDSHT3 HDMI Compliance Test Software is a High Definition Multimedia Interface (HDMI) Compliance Test Solution,
which runs on a Tektronix oscilloscope. This software helps you perform HDMI physical layer validation and compliance
testing.

Key Features

Conformance to HDMI 1.0 standards and test specifications (CTS version 1.1) ensures reliable results
Complete validation to standards with wide range of tests for source, sink, and cable devices
Accurate source tests using precise measurement techniques

Dependable sink tests with closed-loop measurements that eliminate nonlinearities in test setup
Automated sink and cable tests with remote control of signal sources

Automatic mask fit, measurements, and pass or fail notification

In-depth analysis with statistical analysis and mask margins

One-button selection of multiple tests

One-button csv-format summary and reports

Complete compliance solution with an elaborate test fixture, signal sources, and TDR

Documentation

This manual describes the installation and basic operation of the TSDHT3 software. For more detailed information, see the
online help. The following information is available for this product:

TDSHT3 Online Help

Start > Programs > TekApplications > TDSHT3 > Help

TDSHTS3 Online Help (PDF)

TDSHT3 Quick Start User Manual, English (PDF) + @

TDSHT3 Quick Start User Manual, Japanese (PDF)
TDSHT3 Quick Reference Card, Source Test (PDF)
TDSHT3 Quick Reference Card, Sink Test (PDF)

(Documents folder)

B

]
. ]
C:\TekApplications\TDSHT3\Manuals Www.Tektronix.com

Installation Manual: Optional Application Software on
Windows-Based Oscilloscopes

TDSHT3 HDMI Compliance Test Software Quick Start User Manual i



Preface

Software Upgrades

Periodic software upgrades may become available. Note that the software is only operational if you have a valid option key
for the specific oscilloscope model and serial number.

To check for upgrades:
1. Go to the Tektronix Web site (www.tektronix.com).
2. Select Software and Drivers.

3. Enter the product name (TDSHT3).

iv TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Install the Software

Install the Software

The TDSHTS3 software must be installed on a Tektronix oscilloscope. The following models are supported:
= TDS7704B
= TDS7404/B
= (CSA7404/B
= TDS7254/B
= TDS6604B
= TDS6804B
= TDS6124C

= TDS6154C

DPO/DSA70000 series

Before Installation

= TekVisa must be installed on the oscilloscope. If you do not have TekVisa, you can download it from the Tektronix Web
site, in the same location as for Software Upgrades (see page iv).

= Please read the Readme.ixt file on the product software CD before you install the software.

Installation

1. Close all applications.
2. Insert the product software CD into the CD drive of the oscilloscope.

3. The installation wizard will guide you through the installation. If this is a version upgrade, the existing software will be
automatically removed before the new version is installed.

4. The software files will be installed at C:\Program Files\TekApplications\TDSHT3.

Connect to the Oscilloscope

The various tests require specific equipment setups and specific test adapters. Click More within the connect pane to see
how to connect the device under test and test equipment to your oscilloscope. The following test adapters are required:

= Tektronix HDMI TPA-P-DI (for Differential Source tests except Eye Diagram, Over/Undershoot V-H, and
Over/Undershoot V-L)

= Tektronix HDMI TPA-P-SE (for Single-Ended Source tests)

= Tektronix HDMI TPA-P-TDR (for TDR tests) and Source tests (Eye Diagram, Over/Undershoot V-H, and
Over/Undershoot V-L)

= Tektronix HDMI TPA-R-DI (for Cable tests and Sink tests)

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 1



Install the Software

= Tektronix HDMI TPA-R-SE (for Cable tests and Sink tests)

= Tektronix HDMI TPA-R-TDR (for TDR tests and Sink tests)

Start the Software

To start supported 7000-series oscillo-
scopes:

1. From the oscilloscope menu, select
File > Run application > HDMI Com-
pliance Test Software.

2. The oscilloscope display resizes to fit
in the upper part of the screen.

3. The software displays in the lower part
of the screen.

4. Proceed to step 5.

File  Edi Werkical Horiz/Acq Trig Measure  Masks Math Utilities Help
Reference Waveforms 3
Instrument Setup...

Recall Default Setup

lianc

USE2.0 Test Package
Page Setup...

Prink Previev
Print... Chrl+p

Export Setup...
Select for Export 3
Export...

1 Recent Setup Fle 1

Minimize Chrl+M

File Edit Werkical Horiz/Acq Tri

uty © o Lmiplity
3 I
onnact . Summany

Source -> Eye Diagram

Shutdown...

Display Cursors Measure  Masks Math Utilities Help

Factor

Cable Run
Data-Data Tests Single-Ended Tests M
L

Detail

Clock-* Ch1: Data-* Ch2; Rec Length-> BM; CRU-> PLL

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Install the Software

TDSHT3 HDMI Compliance Test Software Quick Start User Manual

File Edit Verical HorizAcq Trig Display Cursors Measure Masks Math

Tek Run  Sample

App Utilties Help Buttons
Restore Application

USB2.0 Test Package
HDMI Compliance Test Software

To start supported B/C-series oscillo-
scopes:

1. Select App > HDMI Compliance Test
Software.

File Edit Verical HorizAcq Trig Display Cursors Measure Masks

2. The oscilloscope display resizes to fit
inthe upper part of the screen. | . A [ A R

Math App Utilities Help Buttons

3. The software displays in the lower part
of the screen.

4. Proceed to step 5.

TDSHT3

Select - Source

Run

Data-Data Test Single-Ended Tests Test
B e | B

Result

Summany
Detail

Select
3 Canfigure
Connect
View
‘Waveform i Select All

Source -» Eye Diagram Clock-> Ch1; Data - Ch2; Rec Length -> 320, CRU -» PLL

Select All

NOTE. To ensure accurate results, calibrate the probes and the oscilloscope before you run tests.




Install the Software

Horiz/Acq Trig Display Cursors Measure  Masks Math Liilties  Help

Tek Secure Erase. .

5. Click Utilities > Instrument Calibra- Fie Edt Vertical
tion to begin calibrating the oscillo- ;
scope for signal path compensation.

6. Click Calibrate.

Set Time & Date...
iaPIE Configuration, ..
LAN Server Status...
External Signals.

Instrument Diagniostics.

Dieassign Multipurpose Knobs

User Preferences. .,

©ption Installation. ..

Calibration Instructions

Status
up

Calibrate

7. Select Vertical > Probe cal to begln File  Edit Vertical Horizfdcg  Trig Display  Cursors  Measure  Masks  Math  Ukiities  Help

Vertical Setup...

calibrating the probes.

8. Connect the probe calibration signal to
the probe.

Zoom Contrals. .,

Display OnjOfF. ..
PasitionfScale...
Label...

Position

Factor

Offset...
Termination. ..
Coupling. ..
Bandwidth. ..

Deskew,
Attenuation. ..

Zoom Setup...
Zoom Graticule Size  »

Display Cursors Measure

Horiz/Acq Trig

Masks  Math Utilities Help

R O OB

Position

9. Click Calibrate Probe. Fle Edt  vertical

A, _‘.-M.-fuw\
T

Pmanhpian

"
el fi Probe Status

Init; il

Clear Probecal

J+| Calibrate Probe
““va @

500
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Install the Software

Close the Software

1. Select File > Exit.
2. You can also click the exit icon.

Using other methods to exit the software
will result in abnormal termination.

3. When you exit the software, you can
restore the oscilloscope to the settings
that were in place before the TDSHT3
software changed them.

File Tests Results Utilities Help

TDSHT3 B x|
Run
Test

Report—

Recall Default
Recall

Clock-Data Tests -Data Tests

Single-Ended Tests

Save...

Eye Diagram -I: k Jditter Intra-Pair Skem

Recall Recent »
Freferences

Minimize

Wi aveform

Souree -> Eye Diagram

Select All

Clock-» Chi; Data-= ChZ; Rec Length -> 1M, CRU -> PLL

Select All

Do you want to restore the oscilloscope settings to
their state prior to starting this application?

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Get Acquainted with the Software

Get Acquainted with the Software

Use the Interface

Use a keyboard, mouse, or touchscreen to make selections in the TDSHT3 software.

Use menus, check boxes, and on-screen buttons to control the software functions. Use Microsoft Windows techniques to
navigate menus and select or clear check boxes.

Device under test (DUT) type Client pane Execution pane

Menu bar Tle Tests Results Utilities Help

TDSHT3 L IS ||
e — -
Differential Tests Single-Ended Tests

. - -_IiﬂerT.:.IF-_rar..::e -Intla-F'air
Configure

Connect

Selection pane

Wieu
U aveform

Status bar Tk -3 hin/b axDitf Swing T...

Input-= Ch; Wiem -= 300

Virtual Keyboard

1. Click a keyboard icon.

File Tests Results Utilities Help

TDSHT3 | X
Run
outputs Test

Clock Datad

Datal Data2 Report—

Wiy

Configure - Sink

Configure

Wi aveform

Sink -> Min-Diff Sensitivity Input-= Ch1; Wiem -> 2.0V

2. Clear the existing text and type the

DTG Pagges Path
new text. Ee € CaTekApplicationATDSHTAP attemnATES T2-6 DiffSensitivity
! @ =
3. Click Enter to confirm your selection. -

=
= 3 - Backspace
{
e T ¥ u

< = 2

NOTE. You must click Enter on the virtual keyboard; otherwise your selections are not valid.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Get Acquainted with the Software

Virtual Keypad

1. Click any number box. File Tests Results Utilities TDSHT3 m| x|

Configure - Source

1 1 Input oHl:lriz.l'l\v:q Reference Levels Run
Click the keypad icon. e mqs 3 uite
*

chi W P -
i steresis
Rec Length Hy: & Report—
10%

chz ¥
180 ¥
Connect umman;

CRU
Wi
W aveform

Source-= Multiple Tests

b

Clock-» Ch1; Data-= Ch2; Ree Length -» 160; CRU -» PLL; High -> 80%; Low - > 20%

3. Clear existing value and enter the de-
sired value.

4. Select a unit of measure.

5. Click Enter to confirm your selection.

NOTE. You must click Enter on the virtual keypad; otherwise your selections are not valid.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 7



Get Acquainted with the Software

General Purpose Knob

1. Click any number box to display the
connection to one of the general pur-
pose knobs.

2. Turn the corresponding knob on the
oscilloscope front panel to adjust the
value for the selected parameter.

3. For better resolution, press the FINE
button.

Set Preferences

1. From the TDSHT3 software menu bar,
click File > Preferences, and then se-
lect an option.

2. Click the option again to clear the
selection.

File Tests Results Utilities Help TDSHT3 m x

Configure - Source

Horizifcq Reference Levels Run
Select -
# of Acgs L Units High -T ast
L ®

Per(%) ¥
confiaure
Hysteresis Mid
Ch2

3

Summary

Connect

Miew N
Wiaweform > Hysteresis

Jl
[ 3

&
(e c00]g B @ B - |
J CJ

Recall Default Confiqure - Source

RecallRecent » ot

File Tesls Resulis Uliliies Help TDSHT3 m| x

Horiz/Acq Reference Leuvels

petal #of Acgs  ® Units High
&

&
Save...
Mid
Position Eye Mask in Center
Acguisiion Alett Message

Source -= Eye Diagram Clock-> Ch1; Data-» ChZ; Rec Length -= 16M; CRU.> PLL

Option

Description

Position Eye Mask in Center

Selected: Positions the mask at the center of the eye diagram.
Cleared: Positions the mask to the left of the eye diagram.

Acquisition Alert Message

Selected: An alert prompts you to specify oscilloscope settings with
which to run the test.
Cleared: TDSHT3 software selects oscilloscope settings.

Trigger
Rise/Fall Time or Over/Undershoot
(Available for B/C-series oscilloscopes only)

These tests can be run with a width trigger or an edge trigger
(default). If the signal has very high intersymbol interference (ISI),
use the width trigger.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Get Acquainted with the Software

Hide and Return the TDSHT3 Software

1. Click the hide icon to minimize the @
TDSHT3 software and enlarge the os-
cilloscope display.

File Tests Results Utiliies Help TDSHT3 ;| %

Configure - Source
Horizihcq Reference Levels

Units High

Hysteresis

.

Rec Length

Summary

To return to the TDSHT3 software: ' petail

Source -> Multiple Tests Clock-= Ch1; Data-» ChZ; Rec Length -> 160; CRU - PLL; High -> 20%; Lo . > 20%

2. For 7000-Ser|es OSC|IIOSCOpeS, Select File  Edit  Wertical  Horizgfacg  Trig  Display  Cursors  Measure  Masks  Math  Ubiities  Help
the APP button.

File Edit Vertical HorizAcq Trig Display Cursors Measure Masks Math | App Utilities Help Buttons

3. For 6000B/C and 7000/B-series oscillo-
Tek Stopped Single Seq 1 Acgs |
scopes, select App > Restore Ap- e

plica“on . HDMI Compliance Test Software

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 9



Use the HDMI Software

Use the TDSHT3 Software

Tests: Process Flow

When you make a test, follow the sequence of actions indicated in steps 1 through 6. Details for each of these actions are
given on the following pages.

N @ e & b

Select a test.
Configure the test parameters.

Connect and configure the equipment.

View the waveform to verify test signal. @

Run the test.
Interpret the test result.

Generate a report.

@

File Tests Results Utilities Help

®

NOTE. For accurate test results, calibrate the oscilloscope and probes before you begin the tests. See page 4.

Select a Test

10

. Click Select.

Click the Source, Sink, or Cable tab.

Move the mouse near a test name until
the test ID appears. This ID corre-
sponds to the Test ID in the HDMI
Compliance Test Specifications.

Select the test that you want to run.

You can select multiple tests, but they
must all be of the same type.

To select all tests of a certain type,
click Select All.

® 6

File Tests Results Utilities Hel)

TDSHT3 | X
Select i o CI > Fun
- Test
Configure Result
e Report —
Rise Time Lo itu

o A vk
Viaw Fall Time
Wiavaform il Time Select All
Sourcs -> Clock Jitter

Clock-> Ch1; Rec Length -= 10; CRU-» PLL

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

Configure the Test Parameters

1. Click Configure. File Tests Results Ufilties Help TDSHT3 m| x|

Configure - Source

2. Use the virtual keyboard or the general 1 Horizihc S ——
i #of Acqs ®
purpose knob on the oscilloscope front .
H Configure
panel to change the values if neces- s o e Lenath PEEEEN L
sary — P epo
’ onneo o

CRU

You can also use the File menu to
restore factory defaults or save and
recall your own configuration settings.

Source -= Eye Diagram Clock-= Ch1; Data-» Ch2; Rec Length -> 16M; CRU -= PLL

Connect and Configure the Equipment

NOTE. If your test uses remote control, the setup diagram in the online help shows how to connect the test equipment by
using an E-net connection. You can either use this method or you can use the GPIB-B connection described on
pages 33 through 36 of this document. Example tests are shown in the Application Examples section, starting on page 19.

1. Click Connect. @ @
2.

Follow the on-screen instructions to Fils Tests Results LUfiiies Help TDSHT3 m x|

connect and configure the device un- &, netruc o tione,

der test and the test equipment. =
3. Click More to view the online help for o :

the selected test, which contains a set- i fon

up diagram. Connect the test equip-
ment as shown in the diagram.

4. If the AWG and DTG are used for the
selected test, select Signal Sources
and configure the test equipment. For
more information, see the remote con-
trol procedure on pages 33 through 36
of this document, or refer to the online
help.

Sink-> Jitter Tolerance Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 11



Use the HDMI Software

View the Waveform

1. Click View Waveform (not applicable
for all tests).

2. \Verify that the waveform in the upper
part of display is similar to the wave-
form that is displayed in the TDSHT3
software.

If the displays are not similar, check
your configuration and connections.

Run the Test

1. Click Run Test.

2. The test will run, displaying a progress
indicator.

12

Horiz/Acq

Trig Display Cursors Measure  Masks Math Utilities Help

View Waveform

Configure

Cunnac’J

L
Selact { o signal(s) as shown. Click Mbra for dataiis. :‘”S“t
.
4 i ] i Result

Vil
Wavetorm |

Dretail

Source - InterPair Skew(D.D) Data A-* Chi; Data B-» Ch2; Thit 1 3503 ns

File Tests Results Utilities Help

| x|

@

Result Summany: Source
Select

Status :

Configure
d Current Test :

Completed :
Connect

Wiy

Wiavaform betall

Gl

Source -> Eye Diagram Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU > PLL

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

Interpret the Test Result

1.

When the test completes, the Result
Summary appears. Check to see if the
device passed the test.

means Pass
El means Fail
[l means Error

If the device did not pass the test, use
steps 2 through 8 to solve the problem,
and then rerun the test.

Click Result Details for a spreadsheet
with details about the test result.

Check the Remarks column. If any er-
ror codes are present, see the online
help for error code descriptions.

File Tests Results LUtilities Help

Result Summany: Source
Test Mame

L /17-10: D'ata Eye Diagram: CK, [
Configure o o

Connect

Wiy
ifaweform

Source -> Eye Diagram

Clock-= Ch1; Data -» Ch2; Rec

NOTE. The parameters in the Result Details dialog box may change depending on the test that you run.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Use the HDMI Software

If you ran an eye diagram test, a plot
appears. You can do the following:

4. Save the image to
C:\TekApplications\TDSHT3\Images -
(you can also change this path). [A—"

Mask Movement
Fine

5. Zoom in and out. ——— :

Reza] ‘
u .
Results

Mask Test

Mask Hits 0
Vswing  952.00mV

6. View the histogram.

[1&7mY £ div ]

7. Move the mask to see the margin of
error.

Thit 1.3482ns

= Voltage

Data Jitter 187ps

8. View statistics.

Hist Pk-Pk  187ps

9. Change the plot to half screen size
(which returns the Result Summary).

10. A plot also appears if you ran the clock
jitter test. In this plot, you will find the
peak-to-peak jitter of the clock.

Results
Result
Pk-Pk 97.6ps
Vswing  932.40mV¥

=
s
=
£
H
2
o
=
Z
S
>

Thit 1.3482ns

-

ITPk-Pk 124.12ps

Hist Pk-Pk  97.6ps

= Time [138psidiv]
alt Screen
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Use the HDMI Software

Generate and Print a Report

You can generate and print a summary or detailed report as described here.
You can also use the Report Generator to create and print customized reports. You can save files as RTF, or in custom file
formats such as RGT, RPL, and RPT. For more information about the Report Generator, see online help.

Summary

After you have successfully run a test or tests, you can generate a report summary as a .csv file.

1. CI|Ck Summary in the execution pane. File Tests Resulis Utilities Help TDSHT3 L

Result Summany: Source Report Configuration

2. A message indicates where the report Select
summary is saved. » - been mve =3
3. Open the file and print the report. ; EEERiey @

Wiy
Wi aveform

Source -» Eye Diagram Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU > PLL

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 15



Use the HDMI Software

16

Detail

After you run a test, you can generate a report that contains default information or information that you configure.

1. Click Result to begin configuring the
report (or skip to step 14 for defaults).

2. Select the input on which you con-
ducted the test.

3. Enter the resolution at which you con-
ducted the test (such as 40 Hz, 43 Hz,
57 Hz, or 60 Hz).

4. Enter the refresh rate at which you
conducted the test (such as VGA,
SVGA, XGA, or SXGA).

5. Note the location where the report will
be saved; you can change the location
if desired.

6. Select Enable Preview to view the re-
port on screen when the report is gen-
erated.

7. Click Clear Report to clear all reports.
Reports generated between this and
the next successful test run will have
no values.

8. Click Advanced.

Report Configuration

Pair {CK, D} Datad b

Resolution

Refresh Rate B0OHz

Report File CATekApplicationsh TDSHT

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

9. Enter the DUT ID (serial number).
10. Enter the DUT details (product type).

11. Enter the pair(s) that you are using for
single-ended and differential tests.
These entries correspond to the con-
nectors on the HDMI adapter; see the
setup diagrams.

12. When this check box is cleared, the
TDSHTS3 software configures the oscil-
loscope to display jpeg images in re-
ports.

If you want to change the default
image export settings, change the
settings in the oscilloscope image

export setup and check this check box.

13. Click OK.

Report Configuration Advanced...

Device 10 TOSHT2 004
Device Details  HOMI Device

Pair {Single-Ended}) I [ atadl

Pair {0, O) @ | Datal- Datad

w_l-_-'.r-_- ozzilloscopesettings for image export
12
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Use the HDMI Software

14. Click Detail in the report pane to gen- 13|
File Edit “iew Object Help
erate the report. L LRI e A
= |

] If Enable PreView |S Se|eCted, the Test ID/Name: 7-10: Data Eye Diagram : CK, D

Report Viewer Utlllty displays the Spec Hange : Data Jitter < 0.3"TEit;
report. Otherwise, a dialog box Wiesp Yalueg RATRESTE

Fesult : Pase

displays the location where the
report was saved.

= For an eye diagram or clock jitter
test, a plot is also displayed.

= You can use the Report Viewer
Edit menu to edit the report, if

i
desired. Thit 1.0000ns
Vewing :  WeD = 864.48mV

m  Use the Report Viewer File menu - | ,
to print the report or export the Resdly o e
report to an RTF file.

NOTE. The report details are real time and no history is maintained. Save the report details before making another test.

18 TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Application Examples
Source: Select All (Clock-Data Tests)

This selection runs a set of tests simultaneously.

Required equipment Example

2 differential probes; Ground lead Tektronix P7330 or later; Tektronix 196-3469-00
1 DC power supply, setto 3.3V Kenwood PW18-1.8AQ

1 EDID emulator Silicon Image TE9100

1 input adapter Tektronix TPA-P-DI

Probe Calibration and Deskew fixture Tektronix 067-1478-xx

1. Click Select. @

2. Click the Source tab. File [ests Results |Utiities Help TDSHT3 | x|

. Fun
3. Click Select All. Select single-Ended Tests

[
D
- gram & Tter P . Intra-Fair Skew
Configure Result

Report—

Source -> Mulliple Tests

4. CI|Ck conﬁgure. Change these Va|ueS File Tests HUtwlmes Help TDSHT3 EJ il

if needed. (You can generally use the P
default Va'ues.) Hof Acgs Units Test

3
o I

Rec Length Report—

Ch2 0%
18 W o
Connect Cummany
Wi 20%
Wiavetorm Jetine

Clock-» Ch1; Data-= Ch2; Ree Length -» 160; CRU -» PLL; High -> 80%; Low - > 20%

Clock-> Chi; Data-> Ch2; Rec Length -> 10M; (

Source = Multiple Tests

5. Click Connect. File Tests Results Utilities Help TDSHT3 EJ x|

Connect

Follow these instructions to set up the connections.
e

b i ore
A
De setup e ke

Report—|
tup the DUT.

SUmman

Wiew )
Wiavaform | MR

Source -» Multiple Tests
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6. Connect and configure the equipment: Digital Oscilloscope

EDID Emulator

= Connect the test equipment as
shown in the setup diagram.

= Configure the source DUT to
output the first supported video
format.

= Configure the EDID Emulator for
the required resolution (refer to the
EDID Emulator user manual).

Source DUT
TPA-P-DI 00.00
0 @O§

7. Cllck View Waveform. File Edit Werkical Horiz/Acq Trig Display Cursors Measure  Masks Math Utilities Help
B fi L 02

Verify that the oscilloscope displays a

e ca] e

similar waveform to the one displayed ’ B . -

) |
RV Y, AR PN e

by the TDSHT3 software. If the
displays are not similar, check your
configuration and connections.

File Tests Results Utiities Help TDSHT3 M| X

View Waveform

Select Waveform skoufd iook like the signal®) as shown. Click Mbra for datails.| Mo '?usnt
@
- ot
Configure Result
Connect Summary
View :
Waveform betail

Source -* Multiple Tests Clock-= Ch1; Data-» Ch2; Rec Length -» 8k; CRU-> PLL; High -» 80%; Low -> 20%
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To ensure accurate results, deskew the File Tests Reslls Uiities Help s | M X |
probes before you run a test. -~ comeat

Select Follow these instructions to set up the connections.

8. Click Connect.
9. Click Deskew.
10. Set the parameters as follows:

m  Select Internal source for this

Source -» Multiple Tests Clock-» Ch1; Data-» ChZ: Rec Length -» 1hi; CRU-* PLL: High -» 80%.; Louw - 20%

example.
= Verify that the From channel is set @
to Ch1 (reference pomt) File Tests Results Utilitles Help TDSHT3 B X
Deskew
m  Verify that the To channel is set to e+
Ch2 (channel to be deskewed). — o v ‘ ‘
-Intemal eport—,
11. Click Run Test to deskew the probes. o e e

Summary
Input Hysteresis #  ReflLevel
.

Wi Chz W
Wi aveform

Hilities -> Desken Click Run Test to Deskew the probes.
12. When deskew completes, click Run @
TeSt t0 run the teSt File Tests Resulis UtilitiesT Help TDSHT3 L il
13. When the test completes, check the e | fesult Summang] Source
. . Select . S ' 'm-'= Pair {CK, D}
test results. For more information, see e
0 . Resolution 8
Interpret the Test Result on page 13. ol et e o
[ 1417-5: Overshoot WI-: D Refresh Rate Report—
14. To generate reports based on the tests comneot | S T ;
that you ran, see Generate and Print a =Hl
Report on page 15. s [l nsbie P

Source - Multiple Tests Clock -» Ch1; Data-= Ch2; Rec Length -» 8k; CRU -> PLL; High -> 80%; Lo . > 20%;

15. After you test the Data0 input pair,
move the probe from Data0 to Data1
and repeat the test. Repeat for Data2.

16. Configure the EDID Emulator for the
next pixel clock rate (VGA, SVGA, and
so on), and test for all three data input
pairs. Only one video format is re-
quired per pixel clock rate.

17. Repeat step 16 for all supported pixel
clock rates.
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Source: Inter-Pair Skew (Data-Data Tests)

This test verifies that the skew between the differential pairs in the TMDS portion of the HDMI link is within the limits

22

stated in the HDMI Specifications.

Required equipment

Example

2 differential probes; Ground lead

Tektronix P7330 or later; Tektronix 196-3469-00

1 DC power supply, setto 3.3 V

Kenwood PW18-1.8AQ

1 EDID emulator

Silicon Image TE9100

1 input adapter

Tektronix TPA-P-DI

1. Click Select.
2. Click the Source tab.

3. Select Inter-Pair Skew.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click Connect.

@

File lests Results Ltilities Help

TDSHT3 | X
_Select - Source

i Cable Run

Clock-Data Tests Dat:
In

Select

ter-Pair
Configure

Connect

e
Wian - o
i awatorm = 1har Select Al

Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100

TDSHT3 L

File Tests Re Utilities  Help
Configure - Source
Horizifcq Reference Levels Run
Test

Data A #of Acgs & High
{3

Ch1 ™

&
Data B f

Chz W Thit - Report—

% of Avgs o
Connect Re-

ch1 W
Miew Existing
Wi aveform Lzlue

Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100

Connect
Select llow these instructions to set up the connections.
@

Report—

Connectthe -
umimany

Wiew

Wi aveform

Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100
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6. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.

= Configure the source DUT to
output a video format with the
highest supported pixel clock
frequency.

= Configure the EDID Emulator for
the required resolution (refer to the
EDID Emulator user manual).

7. Click View Waveform.

Verify that the oscilloscope displays a
similar waveform to the one displayed
by the TDSHT3 software. If the
displays are not similar, check your
configuration and connections.

Digital Oscilloscope

EDID Emulator

0

0o
noo
mo0o

11

o 00000

o eoqm
RN

o 1o
0o

O

o |9

—1 9

2t N

DATAO ©

M

~
R

DATAT

<

g 00 Y

v
> K

®,
 DATA? ||

TPA-P-DI

3|

File Edit Werkical Horiz/Acq Trig Display Cursors Measure  Masks Math Utilities

16 Jun 0 4

View Waveform
Waveform siould look like the siqnal&) as shown. Click Mbre for details.| More

nnnnn

Source - InterPair Skew(D.D) Data A-* Chi; Data B-» Ch2; Thit 1 3503 ns

Source DUT

Help

Summary
Detail

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Recalculate the Tbit value:

8. Click conﬁgul’e agaln ¢ Tests Results Utilities Help

Configure - Source

9. Check that the software is set (default)

Select Input HoriziAcq Reference Levels
Data A o #of Acgs % High
to recalculate the Tbit value. o v

Configure ——
10. If your signal has too much jitter and e e .
your sig hiit e
noise, increase the value in this box L
-Viaw
Wi gvetorm

(defautt = 100). _owa |

Ch1 W

11 . C||ck Run Test and 1hen chck con“n- Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100
ue to run the test with the new Thit val-
ue.
12. When the test completes, check the
test results. For more information, see @
Interpret the Test Result on page 13. File Tesls Resulls Uitz Help wsHTa || X |

Report Configuration

13. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 15.

= i Run
Pair {CK, D} atal il e
L7 -6: Inter-P air Skew: D, D

Resolution 19 ai i
_' Refresh Rate port—|

Conneot
3 Report File ) 15
Wieu
i avatorm iial i Enable

Source -3 Inter-Pair Skew(D D) Data A-» Chi; Data B-> Ch2; Clock-» Ch1; Th

scale; Avgs-> 100
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Sink: Min/Max-Diff Swing Tolerance Test

This test verifies that the sink device properly supports TMDS differential voltages at minimum levels.

Required equipment

Example

Digital Timing Generator

Tektronix DTG 5274 with DTM30 output module

8 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 DC power supply, set to 5.0 V

Kenwood PW18-1.8AQ

1 input adapter Tektronix TPA-R-TDR
1. Click Select.
' DE @
2. Click the Sink tab. File |Tests Redulis Utilities Help TDSHT3 m o x|

3. Select Min/Max-Diff Swing Toleran-
ce.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click Connect.

Select
Differential Tests Single-Ended Tests Test

ng
= ..mter Tolerance . Intra-F air Skew
Configure Result
Report —
Summary
Wi
Wiaveform

Sink-» Min/daxDiff Swing T... Input-» Ch1; Viem -» 2.0V

File Tests Results Utilities Help TDSHT3 m| x
Configure - Sink

elee = Outputs

Clock Datal
al v Bl ¥

Pattern Path

Datal Data2

Connest 2~ Gl

Wiew
Wi aveform

Sink -> Min/b @ Diff Swing T... Input-> Ch1; Viem -> 2.0V

File Tests Results Utilities Help TDSHT3 E X
I
Follow these instructions to set up the connections.

1. Set up the DUT, testfi Report—

Summary

Detail

Sink-> Min/t a-Diff Swing T... Input-> Ch;Wiem - 3.00

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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6. Connect and configure the equipment:

= Connect the test equipment as
shown in the diagram.

= Connect the DTG and oscilloscope
according to the Enable Remote
Control of Test Equipment
procedure on pages 33 through 36.

7. Click Run Test.

8. Follow the series of on-screen mes-
sages.

9. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 13.

10. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 15.

DTG5274

C)C)C) @
C)C)C)

. Oooooo,
C)C)C)C)C)‘

So000 Power Supply
ooooo |3

. ‘
[elelee]Ne)

© © © }

@ Sink DUT

Cable Emulator

File Tests Results Uilties Help

elec

Configure

Connect

Wiew

Wi avweform

2-5: Min-Dift Swing Weltage: CKID

Result Sumiharny: Sink

Pair {CK, D)

Sink -> Min/h 2 Diff Swing T Input-> Chi; Viem -= 300

e
Resolution
Result

Refresh Rate Report —

Report File Summary

[Ed Enabie tep e

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

to the procedure on page 35.
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Sink: Jitter Tolerance Test

This test verifies that your device supports the maximum allowed TMDS clock jitter.

Required equipment

Example

Digital Timing Generator

Tektronix DTG5274 with DTM30 output module

Arbitrary Waveform Generator

Tektronix AWG710 or AWG710B

12 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 cable emulator

JAE DC1P19ST02700AA for 27 MHz tests
JAE DC1P19ST07425AA for 74.25 MHz tests

2 bias tees

Mini-circuits ZFBT-4R2GW

1 DC power supply, setto 5V

Kenwood PW18-1.8AQ

2 input adapters

Tektronix TPA-R-TDR
Tektronix TPA-R-DI

1. Click Select.
2. Click the Sink tab.

3. Select Jitter Tolerance.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click the DTG tab and configure which
DTG outputs that will provide the clock
and data input signals.

Y

File Tests Results Utilities Help

TDSHT3 m| x|

Run
single-Ended Tests Test

(
- Jitter Tolerance .\nlra-F‘sir Skew

Configure Result

Report—|

ummiry

Select

Sink-> Jitter Tolerance Clock-» Ch1; Data-» Ch2; Ree Length -= 16h; CRU -> PLL; Freq Pair-» D,CK: S00kHz, 100 Hz

File Tests Renmes Help TDSHT3 m x|

[ Setup
G o High Ref
/UH = Rec Length
Configure Data —

Chz » Mid Ref

Frequency Pair 10% 50%
D.CK: S00KHzZ.1... ™
Low Ref
- CRIL DUT FreaiMHz)y
Waveform FLL ™ Define T4z5 W

Sink-> Jitter Tolerance Ch1; Data-» ChZ; Rec Length -

®

TDSHT3 | X
onfiqure - Sink
- (" Setup | DTG Fun
= Test

AGM; CRU -= PLL; Freq Pair-= D,Ck: S00kHz,10MHz

File Tests Results Utilities Help

DTG

Se
Outputs
Configure s . Result

Pattern Path
Bl Bl v Report—

e caTekapplicationd =
Connect Datatl Data2

Bz ¥ [
Wiy
Wi aveform

Sink-> Jitter Tolerance Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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6. Click Connect.

7. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.

= When connecting the test fixture to
the DUT, use a cable emulator
specified for the pixel clock rate
being tested.

= Connect the DTG, AWG, and
oscilloscope according to the
Enable Remote Control of Test
Equipment procedure on pages 33
through 36.

= Configure the DUT to receive the
HDMI input signal.

28

File Tests Results Utilities Help

Sink-> Jitter Tolerance

| x|
et
Result

Summary
Detail

Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

TDSHT3

Connect
Follpwthese instructions to set up the connections.

O

IEEE §>
(=)
_§ ooo
SAEEE
5 ooo
@ O]
;
DTG M2
C D
B | )
. 00000,
S I
oo oo |3
OO OOl O
]Hmmﬂ@n\ M2 )
= CH1
( ) masTee
r—“
J | CHi
Power Supply
© © © @J
Sink DUT

== =L

Cable Emulator
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8. Click Run Test.

9. Follow the series of on-screen mes-
sages.

10. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 13.

11. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 15.

File Tests Results Utilities Help TDSHT3 m x

Result Summang} Sink Report Configuration

Name Pair (CK, D}

' WEds-7 closk Jitter. oK : :
| BLcle7: pata diter i 0 Resolution : | 3

Refresh Rate B0Hz jort—

Foan
Test

Connect
Report File it

view | : I —
=t [ Enable Preview e GEIE

Sink-= Jitter Tolerance Clock-» Ch1; Data-» Ch2; Rec Length -> 10; CRU -> PLL; Freq Pair-= D,CK: 500kHz 10MHz

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

to the procedure on page 35.
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Cable: Eye Diagram Test

This test verifies that the cable assembly outputs a compliant data eye.

Required equipment

Example

Digital Timing Generator

Tektronix DTG5274 with DTM30 output module

2 differential probes; Ground lead

Tektronix P7330 or later; Tektronix 196-3469-00

8 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 DC power supply, setto 3.3 V

Kenwood PW18-1.8AQ

2 input adapters

Tektronix TPA-P-DI
Tektronix TPA-R-DI
Tektronix TPA-P-TDR

1. Click Select.
2. Click the Cable tab.

3. Click Configure. Change the values if
needed. (You can generally use the de-
fault values.)

= Test Points. For the first cable that
you test, select TP1 and TP2 to
verify both the input test signal
(TP1) and the output of the cable
(TP2). For successive cable tests,
clear TP1.

= CRU. Ensure that PLL (default) is
selected for compliance testing.

4. Click the DTG tab. Configure which
DTG outputs will provide the clock and
data test signals.

30

File Tests Results Utilities Help

Differential Tests

Cable -> Eye Diagram

Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU -> PLL; TP1 -= true; TP2Z -> true

TDSHT3 | X
Run
Test

Report—

Horiz/Acg
Rec Length

16M ¥

Test Points

Chz
nnnnn ™1 P2

CRU

File Tests Results Utilities Help

Select

Configure

Connect

Cable -* Eye Diagram

TDSHT3 HDMI Compliance Test Software Quick Start User Manual

Configure - Cable

Clock-> Chi; Data-» Ch2: Rec Length -> 16h; CRU -> FLL; TF1 -2 True; TF2 -> True

onfiqure - Cable

Clock-* Ch1: Data-»* Ch2: Rec Length -= AM: CRU-» PLL: TP1 -» true: TP2 -» true

TDSHT3 m x|

Ref Level Units High Ref

Far (%) ¥

Hystere: L3 Mid Ref

Low Ref

TDSHT3 m| x
Run
Test
Outputs
Clock Data0 Fesult

Al W B1 ¥ Report—

Datal Data2 Summary

B2 W™ ch -

D etail
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5. Click Connect.

6. Connect and configure the equipment
to verify the test signal input:

= Connect the test equipment as
shown in the TP1 setup diagram.

= Connect the DTG and oscilloscope
according to the Enable Remote
Control of Test Equipment
procedure on pages 33 through 36.

Select

Configure

Cable -> Eye Diagram

File Tests Results Utilities Help

7 these instructions to set up the connections.
More

1. Setup the DUT, test fi arobes

2. Configure and tes

Power Supply

| x|
Run
Test
Result

Summary
Detajl

TDSHT3

Connect

Clock-* Ch1: Data-* Ch2: Rec Length -= AM: CRU -> PLL: TP1 -= true; TP2 -= frue

Digital Oscilloscope

TPA-P-DI

(e o)

S !WHWWHWH\

Q

(]

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

to the procedure on page 35.
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32

10.

11.

12.
13.

14.

15.

16.

Click Run Test.

Follow the series of on-screen mes-
sages.

When the test completes, check the
test results. These results confirm that
the test signal input is compliant. For
more information, see Interpret the
Test Result on page 13.

Remove the TPA-P-DI adapter and add
the TPA-R-DI adapter as shown in the
diagram.

Add the cable DUT between the
TPA-R-TDR and TPA-R-DI adapters.

Click Run Test.

When the test completes, check the
test results. Pass indicates HDMI com-
pliance of the cable DUT. For more in-
formation, see Interpret the Test Result
on page 13.

Click Configure and set the test point
to TP2.

Replace the cable with another cable
DUT and click Run Test.

To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 15.

Flle Tests Results Utilities Help

Pair (CK, D)

Resolution

O=oc=s

SR <=

0 0“0 0"

S Q000
RS 00-]
—J

@

TDSHT3 By

Report Configuration

| Datan -

TPA-R-TDR

o

[eleelele)

C)C)C) @
C)C)C)

o
9 looooo

C)C)C)C)C)

O

OO0 | =

OOO0OoI o

ummu

©
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Enable Remote Control of Test Equipment

If you are using the specified Tektronix DTG and AWG models, the TDSHT3 software can configure the connected test
equipment automatically as you run tests. If you are using another DTG or AWG, you must configure the test equipment
manually.

Use this procedure to:

= Connect the AWG and DTG for remote control
= Configure the GPIB address for remote control
You will need:

= Tektronix DTG5274, Tektronix AWG710

m  Tektronix 7000 series digital oscilloscope

= National Instruments GPIB-USB-B with the included software, NI-488.2 for Windows

Install NI-488.2 for Windows

NOTE. If you already have NI-488.2 installed on your oscilloscope, ensure that you have the version and installation
parameters that are described in step 1. If you do not, then uninstall NI-488.2, and install it according to step 1.

1. Install NI-488.2 for Windows (ver- @ ,
. =ONI-488.2 for Windows — |0 x
sion 2.1 or later). (AT
i i . )irr Selectthe features to be installed. o Nltnqsos-z
Dunng InSta"atIOnZ High Performance GPIB Software
Feature Description
i - =~ N-488.2
2. Do not install NI-VISA. b<188 | Diiverend Applications
23 +| GPIB Analyzer
. -2 | Language Support
3. Install the Measurement & Automation @ o — v
Explorer. i -- e
- B3 v LabWindows/Cv|
4. When prompted, enable the GPIB- N e
USB interface. 25 ~| Measurement & Automation Explorer
5. Restart the oscilloscope. @
Target Directony
I Browse |

Disk Cost | << Back Next>> TTEencal
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Connect the Equipment

6. Connect the USB-GPIB controller to
the oscilloscope USB port. The oscillo-
scope operating system detects the
USB-GPIB controller and installs the
driver for it.

7. Using GPIB cables, connect (stack) the
DTG and AWG GPIB connectors to the
GPIB port of the GPIB controller.

If your test does not use the AWG,
connect the GPIB-USB-B between the
oscilloscope and the DTG, omitting the
stacked connector from the AWG.

Verify the Equipment Connections

8. Open the Measurement & Automation
Explorer that was installed with the
NI-488.2 software.

9. In the Configuration pane, under De-
vices and Interfaces, right-click the
GPIB device.

10. Click Scan for Instruments.

11. Note the GPIB Instrument Number and
the Primary Address.

12. Right-click the instrument and click
Communicate with Instrument.

13. Click Query and check that *IDN? de-
scribes the correct equipment.

®

USB
GPIB Oscilloscope
B=——==n]f 1o [
AWG :, @ 8 @@[]% ﬁ\g
3 ’ = BHAEARAER
o] OO o %L
:.:.7
(]
L L B ssads )
GPIB (Stacked
@
connectors)
n —= | vall
e Ja— LYo
o GPIB-USB-B
€D
©000|C )
®®
A 27
B aan
¥, Measurement & Aufomation B alglﬂ

File Edit VYiew Tools @ Help

B3 Properties | 2, 5can For Instrumen 5 | 5 N SD\"\/é'°‘n‘3h"2'3r

Configuration | E |GPIBO (G 'ﬂ < showHide

=

IT‘ My SYSt_Em I ame | Ya e | Description

- T Devices and nkerfaces |y ooy 1ok mber 0

4 H- GPIED (GPIE-LISE-E

ﬁ; ;i;ftwara ¢ ) (g] Instrumentd Primary Address ... TEKTROMIX,DTE5274, 1300167

@ Remote Systems Instrument1 Primary Address .., SONYITER,AWGT10,0,5CFT:99
al i

1 121 | o Awibutes

4
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Set the GPIB Bus Timing

14. Right-click the GPIB device and click
Properties.

15. Click the Advanced tab.
16. In the Bus Timing list, select 2usec.

17. Click OK. (Be sure that you complete
the procedure through step 28, where
you will exit the software and restart
the oscilloscope.)

Configure the GPIB Address

18. Start the TDSHT3 software.
19. Click Select.
20. Click the Sink tab.

21. Select a Differential test, such as Jitter
Tolerance.

¥ Measurement & Autoration Explorer X =10l x|
File Edit Yiew Took Help

J E&'Properties | 2, 5can For Instrumenks | H N spy 8, GPIB Analyzer

Configuration rz | GPIBO (GPIB-USB-B)

-:| tA My System

MName | Yalue | Description

- Devices and Interfaces | (g oo e o
i GPIED (GPIE-LISE-E
] é -Sﬁ;ftwara i i Instrumentd Primary Address ... TEKTROMIX,DTGS274, 1300167
@ Remote Systems Instrument1 Primary Address .., SONYITER,AWGT10,0,5CFT:99
| I}

1 1+ W Attibutes

4

29 GPIB Configuration 2 x|

NI-488.2 Setings Advanced |

}7 GFIB-USE-B

Bus Timing: ISDDnsec vl

Parallel Poll Duration: E00nsec

Cable Length for H3488: Off hd

¥ Automatic Serial Polling

[~ Assert BEMN when SC

r [8]% I Cancel

File Tests Results Utilities Help TDSHT3 m x
Sink

Run
Single-Ended Tests Test

[ -
i
. : Toleranoe Intra-Pair
Configure e Result
Report —
SUMTAR
Wi
Wiaveform

Sink-> Jitter Tolerance Clock-> Ch1; Data-= ChZ; Rec Length - 16M; CRU -> PLL; Freq Pair-> b,Ck: 500kHz, 10MHz
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22. Click Connect.
23. Click Signal Sources.

For the Tektronix DTG5274 generator:
24. Click the DTG tab.

25. Click GPIB.

26. Click the AWG tab and repeat.

27. Click Test Conn and look for a mes-

sage that the connection is successful.

28. Exit the TDSHT3 software and restart
the oscilloscope.

File Tests Results Utiities Help HDMI Utility v0.6.3 | 8| | %

Connect
llow these instructions to connect your setup.

Select

Sink-> Jitter Tolerance Clock-» Chi; Data.» Ch2; Reec Length-= 16M; CRU-Clock-> PLL;

T
Al

Signal Sources Setup

GPIE =zetup
Board Type Address
GRIE0 v Primany

Secondary

o [~
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Calibrate probes, 4

Clear report, 16

Client pane, 6

Closing the application, 5
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Configure test equipment, 33
Configure the GPIB address, 35
Connect, 11

Connect button, 10

Connect test equipment, 33
Connections, 1

CSV file, 15
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Deskew, 21

Detail, 18

Detailed report, 16
Device under test type, 6
Documentation, iii

DTG setup, 33
DTG5274, 36

DUT Details, 17

DUT ID, 17

DUT type, 6

E

Edge trigger, 8

EDID emulator, 21
Enable Preview, 16, 18
Error codes, 13
Execution pane, 6

Exit button, 5

Exit the software, 5

F

Factory defaults, 11
File
Exit, 5
Preferences, 8
Run application, 2
Fine button, 8

G

General purpose knob, 8, 11
Generate a report, 15

Generator setup, 33

Get acquainted with the application, 6
GPIB, 36

GPIB address, 35

GPIB bus timing, 35

H

Half Screen, 14
HDMI standards conformance, iii
Hide icon, 9
Hide the application, 9
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Install your software, 1
Make tests, 10
Operate the Application, 10

Installation, 1
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Interface, 6

Intersymbol interference, 8
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Make tests, 10
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Mouse, 6

Multiple tests, 10

NI-488.2 for Windows, 33

0)
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Pair, 16

Pixel clock rates, 21

Position eye mask in center, 8
Preferences, 8

Print a report, 15

Product description, iii

R

Recalculate Thit value, 24
Refresh Rate, 16

Related documentation, iii
Remote control, 33
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Report file formats, 15
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Resolution, 16

37



Index

Restore application, 9
Result Details, 13
Results, 13

Results button, 10
Return to the application, 9
RGT format, 15

RPL format, 15

RPT format, 15

RTF format, 15

Run Test, 12

Run Test button, 10

S

Select, 10

Select button, 10

Select All, 10, 19

Select multiple tests, 10

Selection pane, 6

Set preferences, 8

Signal Sources, 36

Sink, Differential
Jitter Tolerance test, 27
Min/Max - Diff Swing Tolerance Test,

25
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Software upgrades, iv

Source, Data-Data, Inter-Pair Skew
test, 22

Source tab, 10

Source tests, Select All, 19

Start the application, 2

Status bar, 6

SVGA, 21

T

Thit value, 24

TekVisa, 1

Test Conn, 36

Test equipment, 33, 34
Connecting, 11
Setups, 1

Test ID, 10

Test ID 5-3, 30

Test ID 8-5, 25

Test ID 8-7, 27

Test parameters, Configuring, 11

Test results, 13

Tests, Process flow, 10

Touch screen, 6
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View Waveform, 12
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